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Motic Images Plus 3.0 ML is multi-language software offered by Motic China Group Co., Ltd. Itis
especially designed to adjust interactively a live image supplied by a Motic USB camera, capture the
optimized image and perform further analyzing and measuring tasks.

Opening Motic Images Plus 3.0 ML will display the following interface:

Title Bar M Motic Inages Plus 3.0 ML - & x
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The interface is composed of the Title Bar, Menu Bar, Tool Bar, Image Window, Control Panel and

Preview Window.

Menus and tools
The Menu Bar includes the functions File, Edit, Image, Measure, Language, Style, View and Help.
Click the buttons on the Menu Bar to display the corresponding tools.

File

Edit Image Measure Language Style View Help
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File includes the following commands: New, Open,Save, Save As, Export, Capture, Preview, Image

Comparison, Album, Report, Settings and Exit. Shown below is the corresponding tool bar:

Menus and tools / File

/ New

File
] Open Ctri+0

= Save

Bl save As

[ Export

ol Capture Ctr+M

Preview

5]

5 Image Comparison
Album

Report

Settings
Exit

BV 4

The New command enables to create a new image file:

New

Folder
4 @@ Capture Folder
>l foldert
4 @@ Photo Folder
i Biology
[ Industry

Name Untitled
.bmp v
Image Size
Width 540 Pixel
Height 480 Fixel

Select the format of the image file (jpg; bmp; tiff; png) and the file name. “png” is a proprietary Motic

format which can only be opened with Motic Images Software. Define the image size. Capture Folder
defines the location where the new image file should be saved.
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Menus and tools / File / Open
The Open command allows users to open already existing image files:
o= Open | 29 |
’-H. N
'\J\J | . < Programme » Motic » MoticImage Plus3.0 »
Organisieren « Meuer Ordner
1 Mame : Anderungsdatum Typ Grifie
4 Bibliotheken o .
. Motic Drivers 04.09.2017 15:07 Dateiordner
(&= Bilder . - )
. MoticPlus 04,09.2017 15:08 Dateiordner
@ Dokumente . . ;
ab N . moticreport 04.09.2017 15:08 Dateiordner
usi
) . Tool 04.09.2017 15:08 Dateiordner
E Videos = i
5 . web 04.00.2017 15:08 Dateiordner
1@ Heimnetzgruppe
% Computer
&, Windows7_05 (C
< DVD-RW-Laufwe
Dateiname: - [AII media file(*.bmp *jpg *jpec V]
[ Offnen |v] [ Abbrechen ]

Menus and tools / File / Save
The Save command allows to save the current image in the selected format.

Menus and tools / File / Save As

The Save As command provides another method for saving the current image. The following dialog box
will display allowing users to save the image to a different destination and in a different format than its
source.

£ save b4
< v <« Motic » MoticPlus > Photo » v O Search Photo L

Organize v New folder . @

A Name

] Decuments
¥ Downloads Biology
& Music Industry

| Pictures
8 Videos

‘i Local Disk (C)
wa Local Disk (D)
wa Local Disk (E:)

File folder

File folder

s Local Disk (F)

& CD Drive (M)

File name: | v

Save as type: | All media file(".bmp " jpg *.jpeg ".png "tif " tiff) ~

= Hide Folders Cancel

Menus and tools / File / Export
Export saves the current image in a selected path.
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Menus and tools / File / Capture
Selecting the Capture command will bring up the Motic Live Imaging Module to handle images seen
through the microscope connected to the computer.

Note: The capture device can be preset using the Setting command of the File menu or the Setting
button on the File' Toolbar:

Settings

Capture Audio

File Name = Capture + Serial number+ | jpg v

Auto Capture

Every | 1 : Seconds w | Capture one image
A e _ -
Maximum Lapture images 5 -
mage Size | Auto v
Using current date and time as file names

Menus and tools / File / Image Comparison
The Image Comparison command opens a window composed of two frames for a side-by-side
comparison of two images.

Image Comparison
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There are four ways to load the images for comparison:
1. Double click on either frame to load images from the local disk.

2. Right click within either frame and select Load Image from the shortcut menu to load the desired
images for comparison.

Load Image...

Fit to Window

3. Images may also be dragged into either of the frames directly from the Album or Preview window.

4. Click “Load Image” button to import the selected image.

Menus and tools / File / Album
The Album command allows to open already existing images from their thumbnails. It also opens the
general WINDOWS explorer. Click the Album button to bring up the following window:

Album

4 [ Capture Folder
=) folder1

4 5] Photo Folder

AL

=, & 23 e
)
Bencde e oo
AR

=} Biology %
5 Industry biology_2.sfc
= video
4 4 (C)
[ $Recycle.Bin
= Alimama
[ Boot
[=i Config.Msi
= (D)
= (E)
= (F
& (©) biology_e.sfc
= ) )
' S
Folder Amalgamation '1“ ’wl _“i}
i L A1a8)

Menus and tools / File / Aloum / Folder

The upper column displays the Motic Images Plus 3.0 ML image folders, the images captured will be
saved here. The contents of an Image Folders on the left will be shown in a thumbnail display on the
right. Double click on a thumbnail selects a file for single image display; “Drag and Drop” from thumbnail
to Preview window is also possible. With Set default capture folder a predefined path for image storage
can be set.
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Mew

Fename

Delete

Set default capture folder

Refresh

Menus and tools / File / Album / Amalgamation
Amalgamation is a helpful tool for image overlay, especially for multiple stained samples in fluorescence.
Click the Amalgamation tab to display the following interface:

Album -- \Motic\MoticPlus\Capture

D G

Folder Amalgamation

Select the desired images and drag them into the Amalgamation panel. Click the Amalgamation button
and a popup menu listing various amalgamation calculations will be displayed.

Proportional
Add
Subtract
AND

OR
Difference
Multiply
Darkest
Lightest
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Select an amalgamation method and a dialog box will display to confirm the name of the resulting image.
Check the different options to find the best possible amalgamation result. The overlay will be saved in the
format “combination_1.”

Clicking the Remove/Remove All buttons will remove selected image.

Users can also remove an image in the Amalgamation panel by left click for selecting it; then clicking the
right mouse button to bring up the following popup menu:

Remove

Remove All

Menus and tools / File / Report

The Report function is an integral part of Motic Images Plus 3.0 Software. Users are able to load images
and add text fields for printing or export purposes. A report will be saved under proprietary format
moticreport.mwp.

M Motic Images Plus 3.0 ML
File Edit Image Measure Language Style View  Help

D ow Fage Loed ove _J Print Curment Page. File -
[t
18
%“ X
T
=%
+ O~
g tmawe v
| Mossure — ~|

To close the report button click X located in the top right corner.
Click the right mouse button in the Motic Report window to bring up the following popup menu:

Delete

Bring To Front
Send To Back

Full Screen
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Menus and tools / File / Report / Report Tool Bar
The Report Tool Bar is located at the top of the Report window and displays as follows:
New Page

Menus and tools / File / Report / Report tool Bar / New Page
The New Page button creates a new report page.

Menus and tools / File / Report / Report tool Bar / Load
The Load button brings up the following dialog box from which an existing report may be opened.

£ Open X
+ « Motic » moticreport v B Search moticreport »p
Organize « New folder =~ ™ @
B Desktop A Name Date modified Type
5] Documents | meticrepert.mwp §/10/201510:50 AM  MWP File
¥ Downloads [1 moticreport2.mwp 6/10/201510:50 AM  MWP File
B Music || meticreportmwp &/10/2015 1050 AM  MWP File

& Pictures

B videos

e Local Disk (C:)
= Local Disk (D)
= Local Disk (E)
s Local Disk (F)
& CD Drive (M:)

v o« >

File name: | Report ile(*.mwp) v

Menus and tools / File / Report / Report tool Bar / Save

The Save button brings up the Save As dialog box which allows users to save the report documents as
*. mwp format files.

L *
4+ <« Motic » moticrepart v b ticrey v
Organize > Newr folder -
= Documen s A Name
& Downloads [] meticreport.mwp File
b Music [] moticreport2.mwp File
&=/ Pictures | ] moticreport3. mwp File
B videos
e Local Disk (C3)
= Local Disk (D)

= Local Disk (E)
= Local Disk (F:)
& CODrive M)

File name: | test ”

Saveas type: | Report filef*.mwp) -

= Hide Folders Cancel
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Menus and tools / File / Report / Report tool Bar / Print Current Page
The Print Current Page button enables users to preview the current report.

& Print Preview ? X

JEE= R QAR < ¢ 10+ CIHE D&

Menus and tools / File / Report / Report tool Bar / Print Setting
The Print Setting button brings up the Print dialog box.

é Print x
General I
— Select Printer
= Fax @ HP Universal Printing PC
IHP Color Laserlet 2600n = Microsoft Print to PDF
[IHP Laser)et P2055dn UPD PCL 5 M Microsoft XPS Documen
£ >
Status: Ready [ Printtofie Preferences |
Location:
Comment: Network Printer Find Printer... |
— Page Range
& Al Number of copies: |1 33
' Selection € Curent Page
" Pages: ID—‘I ¥ Collate
23/ 523
Enter either a single page number or a single 1 1
page range. For example, 5-12
Print Cancel | soply |

Menus and tools / File / Report / Edit / Text

Motic
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Click the Text button and move the cursor to the location on the report where the text is to be displayed,

click the left mouse button and begin typing.
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Menus and tools / File / Report / Edit / Text / Color
The Color button brings up the Color Palette through which users are able to select a text color.

3
Menus and tools / File / Report / Edit / Text / Font
The Font button brings up the Font dialog box.
Font Microsoft Sans| w | @) w
Size 12px A 4
Font Style Regular w
Paragraph = = =

Menus and tools / File / Settings
The Settings command provides access to the parameter of Still Image capture, image sequences and
Audio options.

Menus and tools / File / Settings / Capture

Click the Capture tab to display the capture settings. Here, define the file name, image size, the
frequency and the maximum number of images to be captured automatically. To choose the Using
current date and time as file names option, click the respective check box.

Click OK to confirm.

Settings

Capture Audio

File Mame = Capture + Serial number+ _.bmp | w
Auto Capture

Every 1 + (Seconds| w) Capture one image
Maximum Capture images 3 =

Image Size (Auto v

® Using current date and time as file names

L o< L cCancel J




Motic

MORE {AN MICROSCOPY

Menus and tools / File / Settings / Audio
Click the check box to the left of the Auto Play option and the music selected in the Playlist of the Control
Panel will play automatically each time Motic Images Plus 3.0 ML is opened. Click OK to confirm.

Settings

Capture Audio

» Auto Play

Menus and tools / File / Exit
The Exit command closes the program after prompting users to save any unsaved files.

Menus and tools / Edit
The Edit Menu allows to define selected areas for further handling. The corresponding tool bar functions

are equivalent:

=,

Undo Ctrl+Z

LIndo Redo
Redo Ctrl+Y
Cut
Cut Copy Paste
Copy
i HE 7™y i
Pazie .- L L
Rectangle Marquee Rectangle Circle Marquee Ellipse
Marguee Marqueeg
Circle Marguee —— - e
- Y i, 1 N
" ‘\_.r’ ‘:..__-" Lgal
Ellipze Marguee
Paolygon Irregular Select All
Prlvonn I
olygon Marguee Marques Marquee
Irregular Marguee 1=
-l
Select A Deselect
region

Deselect region
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Rectangle Marquee

A Rectangle Marquee will be defined by clicking and dragging the left mouse button.

To move the selected rectangular region, place the mouse pointer on the side of the figure, and then click
and drag when the cross pointer appears.To change the size of the selected region, place the mouse
pointer on a corner of the rectangle, and then click and drag the mouse when the hand pointer appears.

Circle Marquee

The Circle Marquee will be defined by clicking the left mouse button to define the center and to drag for
size variation.To move the circle, place the mouse pointer at the center, then click and drag the mouse
when the cross pointer appears. To change the size of the selected region, place the mouse pointer at
the extreme point of the radius, then click and drag the mouse when the hand pointer appears.

Ellipse Marquee

The Ellipse Marquee is defined like a circle. To move the selected elliptical region, place the mouse
pointer at the center of the ellipse, then click and drag the mouse when the cross pointer appears.

To change the size of the selected region, place the mouse pointer at the extreme point of the major or
minor half axis, then click and drag the mouse when the hand pointer appears.

Polygon Marquee

A Polygon Marquee is defined by clicking and dragging the left mouse button.To move the polygon,
place the mouse pointer on the side of the polygon, then click and drag the mouse when the cross pointer
appears. To change the size of the selected region, place the mouse pointer on a corner of the polygon,
then click and drag the mouse when the hand pointer appears.

Irregular Marquee

With the Irregular Marquee command, users are able to define an irregular region by clicking and
dragging the mouse. The selected irregular region may be moved using the drag-and-drop method when
the cross pointer appears.

4+~ Undo
All selected areas can be deleted by or right mouse button: Deselect region

Freeze A
Delete

Delete A
Deselect region

one layer

Up
Dovm o
Uptot
Dow

Fit to Window
Full Screen
Scale
Properties

File Info
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Menus and tools / Image

The Image Menu includes the all commands for a post-capture image correction. The corresponding tool

bar functions are shown below:

File Edt Image Measure Language Style View Help

1 BEB00

)

%3 B

The RGB box displays the color information at the point of the cursor's current location.

765
439

The XY box displays the XY coordinates of the cursor's current location.

Menus and tools / Image / Brightness/Contrast
The Brightness/Contrast command displays separate sliders for both parameters.

Adjust
Brightness o ¢ s | ()
Contrast S | ()

The Default values are both set to “0”. For brightness, the value range is -255 to +255; for contrast it is
-127 to +127.
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Menus and tools / Image / Hue/Saturation

Select the Hue/Saturation command to bring up the following window:

Adjust

Hue

Saturation

— e | 0
— | 0

Motic
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Hue values can be varied from -360 to +360; the default value is “0”. Saturation range is from -100 to

+100; default value is “0”.

Menus and tools / Image / RGB

Select the RGB command to bring up the following window:

Red

Green

Blue

Adjust

E— 0
—— e | 0
O e | 0

The three sliders are used to adjust the red, green and blue color channels of the active image. The value
range always is from -100 to +100 with default value “0”.

Menus and tools / Image / Mirror

The Mirror command mirrors the current image horizontally.

R—

L
File Edit Image Measure Language Style View Help
==
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Menus and tools / Image / Vertical
The Vertical command mirrors the current image vertically.

Menus and tools / Image / Rotate 90
The Rotate 90 command rotates the current image clockwise by 90 degrees.

Menus and tools / Image / Gray Scale
The Gray Scale command converts the current image into a B/W image.

Menus and tools / Image / Invert
The Invert command inverts the current image colors.

Menus and tools / Image / Image Size

Image Size brings up the Image Size dialog box. The units may be "Pixel" or "Percent".

Select the Constrain Proportions checkbox to keep the image proportions even though the image size
is changed. If Width or Height values are changed manually, the corresponding value will automatically
be adjusted to keep the image proportions.

Image Size
Image Size
Width 430 - Pixels | w
Height 384 - Pixels | w

# Constrain Proportions

Menus and tools / Image / Filter
The Filter command allows to apply several filters on the saved image.
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Menus and tools / Image / User defined Filter
The User Define Filter command allows the individual configuration of a filter.

Custom Filter

Untitied Name Untitled
0 0 0 0 0
0 0 0 0 0
0 0 0 0 0
0 0 0 0 0
0 0 0 0 0

Divisor | 9 Bias | 0

To define a new filter, click "New" and enter the name of the new filter. Enter values into the blanks to
create a filter matrix with divisor and bias.
To open an existing filter, select an item from the list and click "Apply".
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Menus and tools / Measure
The Measure Menu includes the commands for measuring several geometrical figures as well as the
guantification tools Auto Segment, Auto Calculation, Calibration Wizard and Calibration Table.

M Motic (mages Plus 3.0 ML
File Edt Image Measure Language Style View
%

Line

biology.4.jog (100%)
[ Rectangle -

1Ie@B00

f

%@ i

3 TN
N 9

Diology 4 ipg

Line

Line measures distances, diameter etc. Click the left mouse button and drag a line. The result is
displayed immediately.

Place the mouse pointer at the extreme point of the line (arrow — hand pointer) and change the length
interactively. Place the mouse pointer on the line, then click and drag the mouse when the cross pointer
appears to move the line.

Rectangle

The Rectangle command measures the width, height, area and perimeter of rectangles. Click and drag
the left mouse button on the image to create a rectangle.

Place the mouse pointer at the vertex of the rectangle, then click and drag the mouse when the hand
pointer appears to change the size of the rectangle. Place the pointer on an edge of the rectangle, then
click and drag the mouse when the cross pointer appears to move the rectangle.

Circle

The Circle command measures the radius, area and perimeter of circles.

Place the mouse pointer at the extreme point of the radius, then click and drag the mouse when the hand
pointer appears to change the size of the circle. Place the mouse pointer on the center of the circle, then
click and drag the mouse when the cross pointer appears to move the circle.

Circle (3 points)

The Circle (3 points) command measures the radius, area and perimeter of circles. Define a circle by 3
points. Place the mouse pointer on any of the three points on the circle, then click and drag the mouse
when the hand pointer appears to change the size of the circle. Place the mouse pointer on the circle,
then click and drag the mouse when the cross pointer appears to move the circle.
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Arc

The Arc command allows users to measure the radius, perimeter, angle and arc length.

Click and drag the mouse to create an arc with 3 points. Place the mouse pointer at one red point of the
arc, then click and drag the mouse (arrow — hand pointer) to change the shape of the arc. Place the
mouse pointer on the arc, then click and drag the mouse (arrow — crosspointer) to move the arc.

Ellipse

The Ellipse command measures the major half axis, minor half axis, area and perimeter.

Place the mouse pointer on the extreme point of the major or minor half axis, then click and drag the
mouse when the hand pointer appears to change the size and shape of the ellipse. Place the mouse
pointer on the center of the ellipse, then click and drag the mouse when the cross pointer appears to
move the ellipse.

Polygon

The Polygon command measures the area and perimeter.

To complete a polygon, double click the left mouse button on the end point.

Place the mouse pointer on any edge of the polygon, then click and drag the mouse when the hand
pointer appears to change the size of the polygon. Place the mouse pointer on any point of the polygon,
then click and drag the mouse when the cross pointer appears to move the polygon.

Irregular

The Irregular command measures the area and perimeter of irregular figures. Click and drag the left
mouse button on the image to drawn an irregular image, release the button to complete the shape
automatically. Click and drag the mouse when the cross pointer appears to move the irregular figure.

Freehand line

This Freehand Line command allows users to measure the length of free lines.

Place the mouse pointer on the free line, then click and drag the mouse when the cross pointer appears
to move the free line.

Angle

3 points set by the left mouse button will define an Angle. Depending on the drawing, the internal or
external angle is measure. Place the mouse pointer at the end of the angle leg, then click and drag the
mouse (arrow — hand pointer) to change the angle. Place the mouse pointer on any point of the angle,
then click and drag the mouse (arrow — crosspointer) to move the angle.

Parallel

Parallel allows to measure the distance between 2 parallel lines. Draw the first line and end it by mouse
click. Moving the mouse creates a parallel line. Both lines can be moved by clicking the grey middle
marking (arrow —cross).

Marker
Using Marker allows to highlight defined points of interest. The x/y coordinates are displayed.
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Auto Calculation

The Auto Calculation command provides detailed data of the objects segmented from the image.

The Auto Calculation Result window will then be displayed, such as number of objects, total area,
percentage of total area, minimum object area, maximum object area, average object area, minimum
object perimeter, maximum object perimeter, average object perimeter and the serial number, area and
perimeter of respective objects.

To access the data of a certain object, click on the object in the image window and the data for that object
will be highlighted.

Click on the data of the desired object(s) and the corresponding object(s) will flicker in the image window.
Click and drag on a particular data item to change its location in the list of results.

M Motic Images Pius 3.0 ML 50w
File Edit Image Measwe Language Style View Help >
D A industry_3.omp (100%)
d
=]
B . Aee Perimater
= ~
D
“

A

X D@ E

Click to bring up the Save As dialogue for export the calculation results as a Text file (*.txt)
or CVS file (*.cvs).

e b
o Save
W | i « Programme » Motic » Motic Image Plu » N e ? F)
Organisieren v Neuer Ordner = @
| Bilder ' Name o e = y
+| Dokumente w
D Musik Motic Drivers 04.09.2¢ S Datesord
) Musil
= MoticPlus fne
B videos
moticreport dne
B Tool !
o, Heimnetzgruppe | ,

web 04,09, 1508 Yateiordne:
lang.txt 04.09.2017 18 extdokument 1 KE
% Computer
&, Windows?_0S (C >

{9 DVD-RW-Laufwe

8 Pisten AYoheY

Dateiname: -

Dateityp: | bet file(".bt) -
= Ordner ausblenden Speichem Abbrechen \

T —
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Calibration Wizard

A correct calibration is essential for any kind of measurement, for correct scale bars and grid dimensions.
The Calibration with Calibration Circle is based on the dot patterns metallized on the glass calibration
slide provided with Motic cameras. The calibration with Scale Cross and Scale Line are intended to be
used in case the smallest dot on the calibration slide is even too large to be captured completely by an
image.

Select the Calibration Wizard command to bring up the following interface:

Calibration Wizard

-alibrate with Calibration Circle Calibrate with Scale Cross Calibrate with Scale Line

Calibration with Calibration Circle

To calibrate with a calibration circle, select the respective Calibration Wizard tab. Click Load Image to
select a calibration circle from your image database. Confirm the objective lens used to capture the
selected image and input the diameter of the calibration circle. Click the Calibration button to open a new
dialogue box. Check the x/y-axis values; they should only differ by one decimal place. Activate the
“Scale” option (if not active by Default setting). This function will adjust e.g. the scale bar depending on
the display mode (resolution, Full screen). Enter a New Sign Name to refind your calibration easily within
the calibration table. Next, click the Save button to finish calibration.

Calibration with Scale Cross

To calibrate with a scale cross, select the respective Calibration Wizard tab.

Click Load Image button to select a scale cross from your image database.

When the image is loaded, a circle will appear on the scale cross. If desired, choose a different color.
Place the center of the circle (set as "O") exactly into the center of the scale cross. Next, take a reddish
marked point ("A") in the X-direction and drag it on the horizontal line to a certain scale division, then
perform identically in Y-direction ("B"). The magnifier window under the image window may help to place
the points accurately.

Confirm the objective lens used to capture the selected image and input the actual length of "OA" in the
"Width" bar and the actual length of "OB" in the "Height" bar. Take note about the scaling of the scale bar.
Click the Calibration button to open a new dialogue box. Continue as under Calibration with
Calibration Circle.
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Calibration with Scale Line

To calibrate with scale line, select the respective Calibration Wizard. This wizard performs calibration in
X-and Y-direction separately, using the same image type: a scale cross.

Click Load Image to open the image of a scale cross. Click the Horizontal tab to activate a horizontal
line overlaying the scale cross. If desired, choose a different color. Extend the line by dragging with the
left mouse button to a defined scale division. Confirm the objective lens used to capture the selected
image and input the actual length.

Please repeat this procedure for Y-direction (Vertical tab). Click the Calibration button to continue as in
Calibration with Calibration Circle.

Calibration Table

The Calibration Table shows all calibration data saved for later usage.

If the Scale check box is selected, the measurement results will stay correct, no matter which display
format/resolution is used.

Calibration Table

Sign names pmipixel-X axis pmipixel-Y axis Objective Scale Signimage width  Sign ima

100X 1 1 100 false 320 240
10X 10 10 10 false 320 240
1 100 100 1 false 320 240
20 5 5 20 false 320 240
2K 50 50 2 false 320 240
3 3 false 320 240
40K 25 25 40 false 320 240

Sign Name Capture

®) Scale

Menus and tools / Language
Select a language from the drop down list.

Menus and tools / Style
4 color styles are provided, click “Style” button and select one of them to switch the interface style.

Style

]

Menus and tools / View
Displays the panel status. When you select it, the panel will display in the software interface.
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Menus and tools / Image / Help

The Help menu has two commands:

Help

Provide detailed instructions on how to use the program.
About

Display the program's copyright and version information.

Control Panel
When an image is opened in Motic Images Plus 3.0 ML, the following Control Panel will display inside
the Edit Tab.

File

Edit

II

Undo Redo

Cut Copy Paste

Rectangle Circle Marquee Ellipse

Marguee Marguee
Polygon Irregular Select All
Marquee Marquee

[Decelect region

Text Paint Audio
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Control Panel / Edit / Text
The Control Panel is composed of the following tabs: Text, Paint, Measure, and Audio.
Click Text in the Control Panel to display the text editing options.

Font Microsoft Sans | w . v

Size 12px

4

Font Style Reqgular

4

Paragraph

Control Panel / Edit / Paint
The Paint tab in the Edit Control Panel allows to draw geometrical figures.

TN R«

Text Paint Audio

The following figures can be drawn: line, rectangle, polygon, circle, ellipse, freehand. All figures can be
edited.

~N ] O
C O <
1]

v 4 v o~

o Fill Color Line Width Line Color

Click the Icon button to bring up a dialog box which provides a variety of icons to add to the
current image.
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Icon
— Current lcon
‘&‘ lllumination
S .
B —
v
b

Select a desired icon and click on a position of the image to place it.

lllumination will vary a shadow-effect representing the direction of an illumination.The slider under the
circles varies the illumination angle.

Click the Rotate 90 button to rotate the icon 90° clockwise.

Control Panel / Edit / Audio
Click the Audio tab to display the Audio control panel:

Paint Audio

fo

]
‘=|'|

(> J[w]{m]

Play List brings up the Playlist window, to which external audio files can be added.

Play list
File Path
Sleep Away.mp3 C-\UsersPubliciMusic\Sample Music\Sleep Away...

Maid with the Flaxen Hairmp3 C-\WeersPublic\Wusic\Sample Music\Maid with __.

Sleep Away.mp3 C:\UeersiPublic\Music\Sample Music\Sleep Away...
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Click the right mouse button in the window to display this popup menu:

Add
Remove

Remove All

To add music to the playlist, select the Add command to display the open dialog box:

£ Open X
« “ 4 |« LocalDisk () » My » Music v ©  Search Music y)
Organize « New folder =~ [ 0

A ~ - ) 3 A
—Thiepe Name Title Contributing artists
&1 TRACKDZ
Deskt
I Deskctop &1TRACKDS
[ Documents &l TRACKD4
4 Downloads @l RACks
S TRACKS
) Music &l TRACKD?
=] Pictures ::-:cjflmcmﬂ
) £ TRACKDS
B Videos E1TRacKI0
i, Local Disk () &lTRACKIL
. Local Disk (D) @lTRackiz
ElTRACKI3
— Local Disk (E) EITRACK14
s Local Disk (F) ETRACKIS .
- CDDrive(M) v < >
Fl\EnamE:‘ V| audio files(*.mp3 ".wav) v

Select the desired music files, click the Open button and the selected music will be added to the playlist.
If the Auto Play option in the Audio panel of the Setting dialog box has been selected, the music in the
playlist will be played automatically each time Motic Images Plus 3.0 ML is started.

To remove the music listed in the playlist, select the Remove All command from the popup menu.

The buttons refer to Start, Pause and Stop.

Clicking dedicates the audio file to an individual image file. Move the cursor onto the image and
click left to display the following box:

<)
0| ®| A3

The buttons ™, 8] and Il refer to Start, Pause and Stop. Click the Record button Bl o display the
Record window with which users are able to record sound, music, etc.
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Click the I button to bring up the Open dialog box from which users can open existing audio files.

=% Open X
« v A <« Local Disk (E) » My » Music v |0 Search Music pel
Organize = New folder ==~ M o
A - # he M
5 This pC Narme 3 Title Contributing artists
(@] TRACKD2
B Desktop &) TRACKDS
Documents @TRACKM
Downloads aTRACKDS
¢ ) €] TRACKDS
J Music (€l TRACKST
[&] Pictures €] TRACKDS
Vid (&) TRACKDS
& Videos @ TRACKLD
iy Local Disk (C3) @I TRACKLL
TRACKLZ
Local Disk (D) @
= 1 TRACKLS
— Local Disk () &) TRACKL4
= Local Disk (F) & TRACKIS .
ﬁ CD Drive (M:)  w <€ >
Elelnemes | v| eudio files(*.mp3 "wav) v
I Open | | Cancel |

Control Panel / Measure
Click the Measure tab to display the Measure control panel.

Measure
Line Rectangle Circle
O ~ @)
Circle (3 Arc Ellipze
Points)
Palygon Irregular  FreeHand Line
VAR
Angle Parallel Marker
Accuracy 2 -
Unit mm v
o
Objective 1% -

Measure Table

Calor G v

E Aute Segment

Auto Caleulation

| Calibration Wizard

Calibration Table
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From the Objective Lens drop down list, select the objective lens that was used to capture the current
image. The color of Auto Segment can be selected.

Color Ol v

E Auto Segment

Auto Calculation

The Measure Table button opens the following window which is composed of two tabs, Measure Table
and Options. The Measure Table tab lists all measurement results.

Measure Table
Measure Table Options
Length Width Height Area Perimeter Radius ~ Major half axis | Minor half a;
L1 | 31.82pm
R1 17.05pm  11.05um | 18839 Squm | 56.2 pm
E1 159.64 Squm | 45.19um 7.95um 6.4 pum
E2 254.6 Squm 62.99 ym 13.28 ym 6.1um
E3 167.34 Squm  47.39pm 9.01 pm 5.91pm
L Cvort

To export the data in the Measure Table, click "Export" to bring up the following dialog box with which
users are able to save the data as *.txt or *.cvs files.

I£ Save ®
+ « Motic > Motic Image Plus 3.0 v & Search Motic Image Plus 3.0 P

Organize *  New folder = @
lir A  Name Date modified Type

File folde

@@ OneDrive web

X | lang 2015/10/15 11:30 Text Document
[ This PC

[ Desktop
£ Documents
¥ Downloads
B Music

&= Pictures

B Videos

i Local Disk (C:) v < >

File name: v

Save as type: | bt file(".txt) ~

~ Hide Folders Cmed

The Measure table can be edited as well:
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Measure Table

Measure Table Options

Preview
Shape Marker Text

Line color o~ o L1
R 100k

Point color @~

Line Width v 6
Point Width -
Line Type -
Apply to Al () Default Apply

Measure Table

Measure Table Options

[ Preview
Shape Marker Text

® Hide Coordinates

L1
T 1009
Flag Color [ R4
Flagpole Color (IR 6
Size -

Applyto All (e Default Apply

Toolbar / Magnifier

The Magnifier is a helpful tool especially for measurements. Start and end of a line, etc. can be precisely
defined.

]
File  Edit Image Measure Language  Style  View  Help
%

Magnifier

1I3EBOO

2]

AX DB E

®

Q

Click the button to increase the magnification up to 800%.and click the button to reduce it.

Preview Window
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The Preview Window is located to the bottom of the image window.
It shows all images actually opened.

."7' | A
| &
LR B at%
biology_8.jpg

How to use the Popup Menus

How to use the Popup Menus.... / ...in the Image window
Click the right mouse button in the image window to display the following popup menu:

Deselect
Lock
Freeze
Freeze All
Delete
Delete All

Deselect region

Up one layer
Down one layer
Up fo top

Down to bottom

Fit to Window
Full Screen

Scale 4

Properties

File Info

Deselect
This command deselects the selected objects.

Lock
This command locks the selected region(s) making it impossible to move it/them around.

Freeze
This command freezes the location and size of the selected figure and fixes it to the image.

Freeze All
This command freezes the location and size of all the figures and fixes them to the image.

Delete
This command deletes the selected region.

Delete All
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This command deletes all regions that have not been locked or frozen.

Deselect region
This command deselects the selected regions.

Up one layer
This command brings the selected region up one layer.

Down one layer
This command brings the selected item down one layer.

Up to top
This command brings the selected item to the top layer when there are several items on the image.

Down to bottom
This command brings the selected item to the bottom layer when there are several items on the image.

Fit to Window
This command resizes the image to fit into the current window.

Full Screen
This command brings the image window into full screen view.

Scale
This command resize the current image by scale.

Properties
This command brings up the properties dialogue to define the selected object's parameters.

Measure Table

Measure Table Options

Preview
Shape Marker Text

Line color o~ o L
1o/ - 100 f
Point color [ IR 4
| 9
Line Width A4 O

Point Width -

Line Type -

Applyto All (@) Default

File Info
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This command brings up the File Info dialog box which provides information about the current image.

File Info

How to use the Popup Menus... / ...in the Album window

Click the right mouse button in the upper column of the Folder panel to bring up the following popup
menu:

El N

New

Rename

Delete

Set default capture folder

Refresh F5

New

To add a sub-folder to the selected folder.

Rename

This command enables users to rename the selected folder.

Delete

This command enables users to delete the selected folder.

Set as default capture folder

This command enables users to set the selected folder as the default capture folder. Images captured
using this program will then be saved in the selected folder automatically.

Refresh (F5)
This command enables users to refresh the contents displayed in the upper column of the Folder panel.
Pressing the F5 key will refresh the contents as well.

Calibration

Any kind of measurement, scale bar or grid needs a precise calibration for a correct quantification.

Place the calibration slide (within the delivery package of your Moticam) into the raypath of the
microscope and focus one a calibration circle (in fact it's a dot). Depending on the objective/camera
adapter/camera sensor combination, the correct dot has to be chosen. As all dots on the calibration slide
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are placed in one line, it is easy just to use the x-drive of the microscope stage to move from one dot to
another. Before taking a picture, note that the selected dot should be grabbed completely, at the same
time being be as large as possible in the image field. This will improve the precision of all measurements.
Click the Calibration button in the Measure tool bar to display the corresponding toolbar.

Calibration Wizard

Calibration Table

Calibrate... / ... with Calibration Circle

Select the Calibration Wizard command. Select a calibration method by selecting the corresponding tab.
Click the Load Image button to open an in image with a calibration circle to be selected for calibration.

O A ki =- 0 @
¢ Bbbotheken
e/ Bilder
4 Debumente
Musik Capture 112 benp
B videos
Dateiname:  Capture_112 bmp v | AN media file(".2mp * Jpg “dper ¥ |

Offnen  |» Abbrechen

Click the Open button to load the selected image.

Select the magnification of the objective used for taking this picture, enter the diameter of the calibration
dot (vacuum-metallized on the calibration slide) in the corresponding box. Click "Calibration” to continue.
Check the x/y-axis values; they should only differ one decimal place. If not, the illumination is
inappropriate.

Please note: The calibration slide is intended to work with transmitted light. In incident light, the dot
appears bright. In this case please invert the image before loading for calibration.



Motic

MORE {AN MICROSCOPY

Activate the “Scale” option (if not active by Default setting). This function will adjust e.g. the scale bar
value depending on the display mode (resolution, Full screen). Enter a New Sign Name to refind your
calibration easily within the calibration table. Next, click the Save button to finish calibration.

[
Calibration Wizard

Calibrate with Calibration Circle Calibrate with Scale Cross Calibrate with Scale Line

Save Sign

Sign Name New Sign
1X () Objective

X um/Pixel (X axis) 1.821862
pm/Pixel (Y axis) 1.803607

60X ®) Scale

(

Calibrate... / ... with Scale Cross

To calibrate with a scale cross, select the respective Calibration Wizard.

Click Load Image button to select a scale cross from your image database.

When the image is loaded, a circle will appear on the scale cross. If desired, choose a different color.
Place the center of the circle (set as "O") exactly into the center of the scale cross. Next, take a reddish
marked point ("A") in the X-direction and drag it on the horizontal line to a certain scale division, then
perform identically in Y-direction ("B"). The magnifier window under the image window may help to
accurately place the points.

Confirm the objective lens used to capture the selected image and input the actual length of "OA" in the
"Width" bar and the actual length of "OB" in the "Height" bar. Take note about the scaling of the scale bar.
Click the Calibration button to open a new dialogue box. Continue as under Calibration with

Calibration Circle.
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Calibration Wizard X

Calibrate with Calibration Circle Calibrate with Scale Cross Calibrate with Scale Line

First, please load an image with
scale cross. Then you'll see a
circle appear on the image. First
putthe center of the circle (setas
\'OV) in the origin of the scale
Major half axis cross, putthe point (set as VAY)
Minor half axis thatis horizontal with the center
Area: 20103.0: of the circle in the horizontal line,
| Perimeter: 502 and put the point (set as VBY) that
is vertical with the center of the
circle in the vertical line.Confirm
the (multiple) object lens used to

Load Image

Circle Color @/ w

This picture is captured with an
objective multiplication of

X v

Width 100 um
Height 100 um

Calibration

Calibrate... /... with Scale Line

To calibrate with scale line, select the respective Calibration Wizard. This wizard performs calibration in
X- and Y-direction separately, using the same image type: the scale cross.

Click Load Image to open the image of a scale cross.

Click the Horizontal tab to activate a horizontal line overlaying the scale cross. If desired, choose a
different color. Extend the line by dragging with the left mouse button to a defined scale division. Confirm
the objective lens used to capture the selected image and input the actual length.

Calibration Wizard X

Calibrate with Calibration Circle Calibrate with Scale Cross Calibrate with Scale Line

First, please load an image with
horizontal scale line in the
\Horizontal\' tab and an image
with vertical scale line in the
\VerticalV' tab. Then you'll see a
line appear on both of the
images. Drag the two ends of the
lines (set as VAV in the horizontal
line and as VBV in the vertical
line) to two different
scales.Confirm the (multiple)
object lens used to capture the

Load Image

Line Color @ w

Horizontal : Vertical

This picture is captured with an
objective multiplication of

X v

Width 100 pm
Height 100 um

Calibration
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Calibration Wizard

Horizontal

Calibrate with Calibration Circle

Length : 79.01 pixels

Calibrate with Scale Cross

Calibrate with Scale Line

First, please load an image with
horizontal scale line in the
VHorizontalV' tab and an image
with vertical scale line in the
\Vertical\' tab. Then you'll see a
line appear on both ofthe
images. Drag the two ends of the
lines (set as VAV in the horizontal
line and as VBV in the vertical
line) to two different
scales.Confirm the (multiple)
| |object lens used to capture the

Load Image
Line Color @ w

This picture is captured with an
objective multiplication of

X v
Width 100 pm
Height 100 um

Calibration Close

Click the Calibration button to continue as in Calibration with Calibration Circle.

Calibration Wizard

Caiibrate with Calibration Circle

Horizontal Vertical

Caiibrate with Scale Cross  Calibrate with Scae Line

First, piease losd an image with I

Save Sign

Sign Name New Sign
Objective

wm/Pixel (X axis)

pm/Paxel (Y axis) 0.578035
® Scale
=D €D
D & r

When calibration is completed, click Save to close the Calibration Wizard.
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The Calibration Table shows all calibration data saved for later usage.
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If the Scale check box is selected, the measurement results will stay correct, no matter which display

format/resolution is used.

Sign image width

Calibration Table

Sign names pmipixel-X axis pmipixel-Y axis Objective Scale

100X 1 1 100 false 320
10X 10 10 10 false 320
1X 100 100 1 false 320
20X 5 5 20 false 320
2% 50 50 2 false 320
3x 33.33333 3333333 3 false 320
40X 25 25 40 false 320
Sign Name Capture

® Scale

Sign ima
240
240
240
240
240
240

240

ok Y oiee 3

4
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	Menus and tools / File / New
	Menus and tools / File / Open
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	Menus and tools / File / Save As
	Menus and tools / File / Export
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	Menus and tools / Image / Vertical
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	The Invert command inverts the current image colors.
	Menus and tools / Image / Image Size
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	Circle
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	Freehand line
	Angle
	Marker
	Using Marker allows to highlight defined points of interest. The x/y coordinates are displayed.
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	Calibration Wizard
	Calibration with Calibration Circle
	Calibration with Scale Cross
	To calibrate with a scale cross, select the respective Calibration Wizard tab.
	Calibration with Calibration Circle.
	Calibration Table
	Menus and tools / Language
	Menus and tools / Style
	4 color styles are provided, click “Style” button and select one of them to switch the interface style.
	Menus and tools / View
	Displays the panel status. When you select it, the panel will display in the software interface.
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	Help
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	Control Panel
	When an image is opened in Motic Images Plus 3.0 ML, the following Control Panel will display inside the Edit Tab.
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	Toolbar / Magnifier
	Preview Window
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	Deselect
	This command deselects the selected objects.
	Lock
	Freeze
	This command freezes the location and size of the selected figure and fixes it to the image.
	Freeze All
	This command freezes the location and size of all the figures and fixes them to the image.
	Delete
	This command deletes the selected region.
	Delete All
	Deselect region
	This command deselects the selected regions.
	Up one layer
	This command brings the selected region up one layer.
	Down one layer
	This command brings the selected item down one layer.
	Up to top
	This command brings the selected item to the top layer when there are several items on the image.
	Down to bottom
	This command brings the selected item to the bottom layer when there are several items on the image.
	Fit to Window
	This command resizes the image to fit into the current window.
	Full Screen
	This command brings the image window into full screen view.
	Scale
	This command resize the current image by scale.
	Properties
	File Info
	This command brings up the File Info dialog box which provides information about the current image.
	How to use the Popup Menus... / ...in the Album window
	Calibration
	Any kind of measurement, scale bar or grid needs a precise calibration for a correct quantification.
	Calibrate... / ... with Calibration Circle
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	Calibrate... / ... with Scale Line
	When calibration is completed, click Save to close the Calibration Wizard.

